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DERM's Plan Review Process

Topics of discussion:

¢ Site Plan Reviews

¢ Water and Wastewater Reviews
¢ Wellfield Protection Areas

© Specialty Reviews



This information will help you to
understand the core functions of DERM
related to the following:

¢ Plan Review
¢ Business Tax Receipts (BTR)

Also known as:
v Certificate of Use (CU)
v Occupational License (OL)
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DERM'’s Role and Responsibilities

¢ Enforcement of Chapter 24 and 11C (only in
unincorporated MDC) of the Miami-Dade County
Municipal Code. www.municode.com

¢ Enforcement and compliance of federal and
state delegated programs including:

» Air » Solid Waste

» Asbestos » Storage Tanks
» Industrial Waste Pretreatment
» Sewer capacity certification (aka. Allocation Program)
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DERM'’s Plan Review and
Developmental Approvals Division

( ') ur main responsibility is to review building
permits, Business Tax Receipts (including

Certificates of Use and Occupancy, and Occupational
License applications) to ensure that Federal, State,
and County (Chapter 24 and Chapter 11C of the
Miami-Dade County code) environmental protection
laws are complied with.
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Information Outline
Planning Tools

Business Tax Receipts (Certificates of Use/
Occupational Licenses)

Dynamics of the Plan Review Process
Overview of Core Plan Reviews

Overview of Specialty Plan Reviews
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1. DERM Planning Tools

¢ Letter of Interpretation - determine if use NE iy
can be approved before investing,
purchasing, renting, leasing, etc.

¢ Pre-submittal meeting - helps design professmnal to
comply with DERM requirements before submitting plans.

¢ Rework meeting - helps design professional to
understand the pending disapproval comments before
resubmitting plans.

¢ EQCB (Environmental Quality Control Board) - variance
from Chapter 24 requirements.
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2. DERM Business Tax Receipts - BTRs

(Certificates of Use/Occupational Licenses)

Sec. 24-17. Certificate of occupancy. -

chapter, and no such facility or project shall commence operations, until the Director or the Director's designee certifies that the work has bee
completed in strict cormpliance with the approved plans and specifications, and that there is good cause to believe that the facility or project wilky,
operate in accordance with the provisions of this chapter and an operating permit has heen obtained from the Director, ;

(0340 8L 5 JINGUODEILG s g, b ot ol

Mo certificate of occupancy shall be issued by the County or any municipality for any facility or project subject to the provisions of thi

Establish use/new applications - may need operating permits
Change of owner/name - need to update operating permits
Existing business changing address

Change of use - retail space to office space

Adding to existing business - e.g. adding seats to a restaurant
Bringing businesses into compliance (if possible) that were not

previously approved by DERM
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Submit application to DERM’S BTR (CU/OL) REViEW

municipality

Bring municipal ImmEdiate
application to DERM .
review - usually
completed
within an hour

DERM Core Review

Correct Disapprovals

Approved?

! cashier stamped on CU/OL.IS:Sue.d by
application municipality
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DERM'’s Plan Review Services

3 OFFICE LOCATIONS

¢ DERM West Dade Plan Review Office
11805 SW 26 St. (coral Way)
786-315-2800 (e
7:30 am to 4:00 pm . .

© PERMITTING AND INSPECTION CENTER

» Unincorporated Area Plans
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DERM'’s Plan Review Services

¢ DERM Review Hialeah Office
Occupational License Only -
No Plan Reviews

501 Palm Ave.
k% (Hialeah City Hall-2" floor)

305-492-2004
7:30am to 4:00 pm

¢ DERM Downtown
Plan Review Office
/701 NW 1 Court
(OTV -2 floor)
305-372-6899
8:00 am to 4:00 pm

- » Municipal Area Plans
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Plan Review

Common DERM-Municipality Interactions
Excerpt from Chapter 24-43.1 (3)

(3) Motwithstanding any provision of this Code, no County ar municipal officer, agent, employee or Board shall approve, grant ar issue any '
building permit, certificate of use and occupancy (except far changes in ownership), municipal occupational license (except for changes in ™
owmnership), platting action (final plat, waiver of plat or equivalent municipal platting action) or zoning action {(district boundary change, unusual
use, use variance or eguivalent municipal zoning action) for any residential land use served or to be served by a septic tank ar any source of
potable water supply until the County or municipal officer, agent, employee or Board affirmatively determines that the residential land use will
comply with ane (1) or more of the requirements as set farth in Sections 24-43.1(3)(a), (b)), (c), (d), (e}, and (f) and Section 24-43 2(1) of this
Code, and, additionally, that the property is not within a feasible distance for a public water main or public sanitary sewers.
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» All New Construction - residential and commercial
» All additions

» Commercial interior renovation/remodeling
» Demolition - all commercial and residential
» Commercial re-roof

» Tank upgrades, installations, removals

\ 4

\ 4

\ 4

\ 4

\ 4
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DERM Plan Review West Dade Office
municipality

Submit plans to H i .
ML Residential Plans-
Miami-Dade Building 4 dayS
Department .
Commercial Plans-
8 days
Expedited Review-
| available for
Approved? additional fee

Pay for review at T“;‘kefP'aTS to DERIIVI
Miami-Dade or final approva

Building Dept.
cashier

Pick up plans via
Miami-Dade Building
Department

Correct Disapprovals
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prreresa  DERM Plan Review Downtown Office
municipality -

Submit plans to Residential Plans-
DERM |
‘ 4 days
Commercial Plans-
8 days

Pick up plans at
DERM

Correct Disapprovals

2 Expedited Review-
_ Approved? available for

Pay for review at Take plans.to DERM
DERM cashier Pla.n Review for
final stamp
& y MIAMI-DADE
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CU/OL Reviews - Operating Permits

Commonly Issued Permits:
» Grease Discharge Operating (GDO) Permit
» Solid Waste
» Industrial Waste Permits (IW-2 through IW-6 and IWP)
» Air Permit:

v APCEF (chlorofluorocarbon - refrigerant)

v APVR (vapor recovery)
» Potable Water Operating (PWO) Permit
» Domestic Waste Operating (DWO) Permit
» Private sanitary Sewer Operating (PSO) Permit

» Marine facility Operating Permit (MOP)
MIAMI-@
COUNTY

?56[;’1'67‘;’?5 Excellence Every Day



DERM'’s Final Approval Stamp

PROPER use of stamp

DERM

PLAN REVIEW

FINAL

{

3

¢
APPROVAL ;
r

RESOURCES MANAGEMENT

CORE REVIEWEER (FRINT):

SIGNATURE DATE
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IMPROPER use of stamp

/ E;gl ichment B:

New Plan Review Red Stamp

ELAN REVIEW

FINAL
APPF\‘OVAL

DEPARTMENT OF ENVIRONME
RE&DURCE.B MANA(:EMENT
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3. Dynamics of the DERM Plan Review Process
¢ Clarification of the DERM “Black Box” effect

3

Plans IN Plans OUT )
DERM

Plan
Review

¢ The DERM Review includes various trades

» Example: Proposed new facility with associated
parking lot and emergency generator to be
constructed on a contaminated site

DERM Initial Storage Paving & Final
Intake of - Core - Tank N PELEE N Drainage I Core
Plans V] Review V] Review V|  Review V] Review | Review
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Dynamics of the DERM Plan Review Process

TTETTS TS TEELT

by Zoning &

delivered to Plan 900 am
Central
o DERM Clerk picks up plans from

d Plan Central

¥

DERM Clerk
assigns plans to
Core Reviewers

T
Clerk delivers plarlito Core Reviewers.

DERM Core Initial

AN A I A TN A M 4

Review
Core Reviewers deliver
plans to Specialty Reviewers
: 4
i Residential = 4 days
| Commercial = & days .
i DERM Specialty It g?;ic:"}l’
) Reviews not required
Specially Reviewears retum
plans to Core Reviewers
: 4
DERM Core Final
Review
Core Reviewers take 8:10 am
plans ta DERM Plan Bin, 11:00 am
Clerk takes plans 2:00 pm
o Plan Central 300 pm
¥ B
Y
Plan Central

ey

Core Review Duties:
» Water Supply Review
» Wastewater Review
» Wellfield Protection

Flood Review (when applicable)

V%;f

» ldentification of Specialty Reviews

Specialty Review Types:

» Air » Pollution Remediation

» Asbestos  » Water Control

» Coastal » Industrial

» Wetlands » Storage Tanks

> Trees » Industrial Pre-Treatment

» Paving and Drainage
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4. Overview of Core Plan Reviews

A - Wellfield Protection Reviews

B - Water Supply / Wastewater
Reviews

C - Triggers for Water and Sewer
Connections
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4.A. - Wellfield Protection Reviews

If you don’t know, ask us about:

» Definition of Terms
» Wellfield Maps

» Wellfield Restrictions
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Municipalities within Wellfield
Protection Areas

Florida Homestead] Medley Miami Miami Virginia
City Gardens Springs Gardens

Northwest Florida Hialeah Harris Hialeah WE Hialeah  Westside  Alex Orr Hialeah
City Preston Park Preston Oeffler Preston Max Preston
Florida Newton Miami
Keys Springs
Aqueduct Wittkop Lower
Park
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4.B - Water Supply / Wastewater Reviews

» Abutting » Sewage Loading

» Feasible Distance » Sanitary Sewer Connection

» Availability Requirements

» Water and Sewer » Allocation Letters
Extensions » Verification Forms

» Well Requirements

» Septic Tank Requirements
» Lot Size Requirements
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Types of Potable Water

The majority of projects have some form of

water supply system. It is the responsibility of
the DERM Core Reviewer to determine whether
the project is being served by one of the following
types of water supply:

v Public Water

v Potable Well
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Types of Sanitary Disposal

The majority of projects also have some form of wastewater
disposal system. The DERM Core Plan Reviewer is to
determine whether the project is being served by one of
the following types of wastewater systems:

» Gravity Sewer Main
» Sewer Force Main

» Septic Tank
» Temporary Holding Tank
» Package Treatment Plant
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4.C — Triggers for Water and Sewer Connections

Abutting Lines

If 2 water or sewer line is available and operative within the
public right-of-way or easement abutting the property, the
residence or building must connect within 90 days.

BT ; Feasible Distance - is the distance
o abut-ted, a‘but-ting, a-buts,
. ( from the closest property line to
- &> hearest point of connection of an
To touch or end at one end or side; lie adjacent. ‘ . . .
# available water or sewer line in

v . .
¢ accordance to the criteria set by
1. To bord dat; b t o, e . .
2 Tosupportas an abatment, < Chapter 24. This is not necessarily the
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Water/Sewer Main Extensions
An extension is required only when:

» A water/sewer line is within feasible distance, and

» A use cannot be approved without being served
by public water, and/or

» A use cannot be approved without being served by
sanitary sewers, and

» The verification form from the utility states
“will have” (instead of “does have”).
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Water/Sewer Main Extension (cont)

¢ As a part of the plan review, the applicant must
provide a valid Water Extension (WE) number for the
approval of the water main and/or a valid Sewer
Extension (SE) number for the approval of the sewer.
The approval of the building permit will include a
hold on the CO for certification of the respective
extension.
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5. Overview of Specialty Plan Reviews

¢ Natural Resources Reviews
v Trees
v Wetlands
v Coastal

¢ Paving & Drainage

¢ Water Control

¢ Pollution Remediation
¢ Air

¢ Industrial Facilities / Pretreatment / Storage Tanks

¢ Asbestos
MIAMI-DADE
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Natural Resources Review

¢ Trees

» Required for the removal or relocation of any tree that is not
exempted under Section 29-49(4). DERM will review the tree
issues in Miami-Dade County, with the exception of:

v Coral Gables v City of Miami
v Homestead v Miami Springs

v North Miami ¢ North Miami Beach
v Pinecrest v South Miami

» Natural Forest Communities and Pinelands
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Natural Resources Review (cont’d)

¢ Freshwater Wetlands
» Triggers that would initiate a full review:
v Wetlands Area of Concern, Wetlands Basin, Hydric Soils
¢ Coastal
» Triggers that would initiate a full review:

v Work over a tidally influenced waterway
(Inlet, River, Coastal Area)

v Examples include: Seawall, Dock,
Boat Ramp
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Industrial Facilities / Storage Tanks

¢ Triggers that would initiate a v/ Auto repair shops
full review: v Dry cleaners
» Projects that involve the v/ Photo labs
possible use, handling, storage, v X-Ray processing
discharge or generation of any v Laboratories
hazardous materials. The v Manufacturing operations

storage of these materials
include any storage tanks.

» Examples include:
v ASTs (above ground storage tanks)

v USTs (underground storage tanks)
v Power generators
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Industrial Waste Pretreatment

¢ Trlggers that would initiate a full review:

» These types of reviews are very closely associated with the
Industrial Facilities reviews. These are typically large-scale
industrial processes (>25,000 gallons/day) that require a
Pretreatment Permit.

» Examples include:

v Bottling / Canning Facilities

v Large Scale Food Processing
Operations

v Electro-plating Facilities

v Pharmaceutical Manufacturing

v Leather Tanning

v Paint Manufacturing

| _ MIAMI-DADE
- -fn'amidade'gov . COUNTY

@t/f}‘ﬁ‘;}g Excellence Every Day




Paving and Drainage (P&D)

¢ Triggers that would initiate a full review:
» Roadways

» Parking areas (not including single family
homes or duplexes) - ¥
| o ' 15 R — : P

» Drainage system
» Work on a canal
» Work on a lake

¢ “P&D only” reviews are not
performed (Full Core Review)
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Water Control

¢ Triggers that would initiate a full review:

» Environmental Resource Permit (ERP)
» Dewatering
» Drainage Wells

» Qutfalls

» New P&D on Wetlands
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Pollution Remediation Reviews

Trigger Subject

Property

Dump Site
Landfill

Contaminated
Site

Super Fund
Site

L < K<

Solid Waste

| P MIAMI-DADE
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Air / Asbestos Reviews

¢ AIr - Triggers that would initiate a full review:
Venting Systems
Facilities producing emissions (i.e. volatiles)
v Examples: Dry cleaning facilities, body shops, etc.

HAPs (hazardous air pollutants) (f
¢ Asbestos - Triggers that would initiate a full review:
Demolition

Roofing activities

Disturbing 160 square feet or more of
construction material o

Disturbing 260 linear feet or more of 7_
construction material —

Lo, > MIAMI-DADE
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Questions?

Ask our
Plan Review Staff

or visit us at
WWW.MIAMIDADE.GOV/DERM

OO0
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